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lkekU; Kku

1.	 çkphu gM+Iik 'kgj fdl unh ds orZeku esa lw[ks 
ekxZ ds rV ij cuk;k x;k Fkk \

		  (A)	 ;equk	 (B)	xaMd

		  (C)	 dkslh	 (D)	jkoh

2.	 fuEufyf[kr esa ls fdl unh dk uke ½Xosn esa 
dsoy ,d ckj vk;k gS \

		  (A)	 xaxk	 (B)	 fla/kq

		  (C)	 >sye	 (D)	ljLorh

3.	 egewn xtuoh ds lHkh vkozGe.kksa (1000 bZ- ls 
1026 bZ- ds chp) esa lokZf/kd egRoiw.kZ vkozGe.k 
dkSu-lk Fkk \

		  (A)	 eqYrku HkfVaMk ij vkozGe.k (1004)
	 	 (B)	 ukjk;.kiqj ij vkozGe.k (1002)
		  (C)	 lkseukFk eafnj ij vkozGe.k (1025-26)
	 	 (D)	 dkfyatj ij vkozGe.k (1019-23)

4.	 dSIVu gkWfdUl (Captain Hawkins) us fdlds 
'kkludky ds nkSjku Hkkjr dk nkSjk fd;k\

	 	 (A)	 ckcj	 (B)	 'kkgtgk¡

	 	 (C)	 tgk¡xhj	 (D)	vdcj

5.	 Hkkjr ds fuEufyf[kr esa ls fdl usrk }kjk ,d 
LoSfPNd laxBu&[kqnkbZ f[knerxkj LFkkfir 
fd;k x;k Fkk\

	 	 (A)	 eqgEen vyh ftUuk

	 	 (B)	 ekSykuk eksgEen vyh

	 	 (C)	 [kku vCnqy x¶Qkj [kku

	 	 (D)	 gdhe vtey [kku

6.	 eksfguhvêe fdl jkT; dk 'kkL=h; u`R; gS \

		  (A)	 vle	 (B)	 dukZVd

		  (C)	 dsjy	 (D)	rfeyukMq

7.	 fuEufyf[kr esa ls dkSu&lk izns'k phu esa lhek 
lk>k ugha djrk gS \

		  (A)	 v#.kkpy izns'k	 (B)	 fgekpy izns'k

		  (C)	 if'pe caxky	 (D)	mÙkjk[k.M

8.	 dasæh; ued o leqæh jlk;u vuqla/kku laLFkku 
----------------- eas fLFkr gSA 

		  (A)	 iatkc	 (B)	 NÙkhlx<+
		  (C)	 mÙkjk[kaM	 (D)	xqtjkr

9.	 fuEufyf[kr esa ls p;u djsa] lkSjeaMy dk lcls 
xeZ xzg dkSu&lk gS \

		  (A)	 eaxy	 (B)	 'kqØ
		  (C)	 cq/k	 (D)	c`gLifr

10.	 ikfjfLFkfrdh esa v/;;u fd;k tkrk gS&

		  (A)	 i{kh

		  (B)	 lsy ds fuekZ.k dk

		  (C)	 thoksa ,oa i;kZoj.k ds chp lEcU/kksa ds 
v/;;u dk

		  (D)	 Årdksa dk

11.	 Hkkjr ljdkj vfèkfu;e] 1935 ds ckjs esa 
fuEufyf[kr esa ls dkSu&lk ,d dFku lgh 
ugha gS\

		  (A)	 izkUrh; Lok;Ùkrk vfLrRo esa vk;h

		  (B)	 f}lnuh foèkkue.My Ng izkUrks a es a 
micfUèkr fd, x,

		  (C)	 lkEiznkf;d fuokZpu {ks= vkSj vfèk& 
izfrfufèkRo d s fl¼kUr vkxs vk Sj 
foLrkfjr fd, x,

		  (D)	 jkT;ksa dks egkla?k eas izfo"V gksus ds fy, 
ckè; fd;k x;k

12.	 lwph-I dks lwph-II ds lkFk lqesfyr dhft, vkSj 
lwfp;ksa ds uhps fn, x, dwV dk iz;ksx dj lgh 
mÙkj pqfu, %

        lwph-I	      lwph-II
  (Hkkjr ds lafo/kku	       (fo"k;)
	 ds la'kks/ku)

a.	 52ok¡ la'kksèku	 1.	 ernku vk;q
	 vfèkfu;e] 1985		 21 o"kZ ls de 	
			   djds 18 o"kZ 	
			   djuk

b.	 73ok¡ la'kksèku	 2.	 f'k{kk dk vfèkdkj

	 vfèkfu;e] 1992	

c.	 61ok¡ la'kksèku	 3.	 iapk;rh jkt

	 vfèkfu;e] 1988

d.	 86ok¡ la'kksèku	 4.	 ny&cny ds
	 vfèkfu;e] 2006		 vkèkkj ij 
			   v;ksX;rk

dwV %
			   a	 b	 c	 d
		  (A)	 4	 1	 3	 2
		  (B)	 4	 3	 1	 2
		  (C)	 2	 3	 1	 4
		  (D)	 2	 1	 3	 4

13.	 nwljh iapo"khZ; ;kstuk ds y{;ksa ds laca/k esa 

fuEufyf[kr esa ls dkSu-lk dFku lgh ugha gS\

		  (A)	 vk/kkjHkwr vkSj Hkkjh m|ksx lsDVj dk 

fodkl

		  (B)	 thou Lrj dks c<+kus ds fy, jk"Vªh; vk; 

esa o`f¼

		  (C)	 miHkksDrk oLrq lsDVj dk foLrkj

		  (D)	 jkstxkj ds voljksa dk foLrkj

14.	 xzSeh iqjLdkj ls lEekfur igyh Hkkjrh; efgyk 

dk uke crkb,A

		  (A)	 rUoh 'kkg	 (B)	 vuq"dk 'kadj

		  (C)	 vk'kk Hkkslys	 (D)	vuU;k fcjyk

15.	 ßXykscy dkWEifVfVousl fjiksVZÞ fuEufyf[kr esa 

fdl laxBu }kjk tkjh dh tkrh gS\

	 	 (A)	 MCY;wVhvks	 (B)	 McY;wbZ,Q

	 	 (C)	 lkdZ	 (D)	bZ;w

16.	 cgqr cM+h nwfj;ksa] tSls [kxksyh; nwfj;ksa] dks 

ekius ds fy, SI ek=d _______ gSA

	 	 (A)	 [kxksyh; ek=d	 (B)	 çdk'k o"kZ

	 	 (C)	 fdyksehVj	 (D)	ehVj

17.	 CNG dk iw.kZ :i D;k gS\

	 	 (A)	 dkcZuhÏr çkÏfrd xSl

	 	 (B)	 ngu'khy ukbVªkstu xSl

	 	 (C)	 laihfM+r çkÏfrd xSl

	 	 (D)	 jklk;fud çkÏfrd xSl

18.	 fuEufyf[kr esa ls dkSu&lh /kkrq lokZf/kd rU; 

(ductile) gS\

	 	 (A)	 fyfFk;e	 (B)	 lksfM;e

	 	 (C)	 ysM	 (D)	lksuk

izSfDVl lsV-1
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19.	 fuEufyf[kr esa ls dkSu-lk ,ddksf'kdh; tho 
dk mnkgj.k gS\

	 	 (A)	 ?kjsyw eD[kh	 (B)	 gkbMªk

	 	 (C)	 vehck	 (D)	 fNidyh

20.	 ikpu xzafFk;ksa vkSj muds ,atkbeksa ls lacaf/kr 
xyr ;qXe dk p;u dhft,A

	 	 (A)	 vXU;k'k; - vX;k'k; jl

	 	 (B)	 ;Ïr - fiÙk jl
	 	 (C)	 ykj xzafFk - fVªfIlu

	 	 (D)	 tBj xzafFk - isfIlu

dEI;wVj lk{kjrk

21.	 -------------- izfØ;k vkids dEI;wVj ij LFkkfir 
vkWijsfVax flLVe dks eq[; eSeksjh ;k jSaMe 
,Dlsl eSeksjh (RAM) esa yksM djrh gSA

		  (A)	 baMsDl	 (B)	 QkWesZV

		  (C)	 cwV	 (D)	eSi

22.	 ekbØksçkslslj 8085 esa] fuEufyf[kr esa ls 
dkSu-lk 16 &fcV jftLVj gksrk gS\

	 	 (A)	 ¶ysx jftLVj	 (B)	 LVsd ikWbaVj

	 	 (C)	 W jftLVj	 (D)	Z jftLVj

23.	 PCB dk Qqy QkWeZ D;k gS\

	 	 (A)	 fçaVsM daVªksy cksMZ

	 	 (B)	 fiDpj daVªksy cksMZ

	 	 (C)	 fiDpj lfdZV cksMZ

	 	 (D)	 fçaVsM lfdZV cksMZ

24.	 fjä LFkku Hkjus ds fy, lcls mi;qä fodYi 
pqusaA

ekbØksçkslslj 8085 esa _______,Mªsl ykbu 
gksrh gSa] blfy, ;g eseksjh dk ________rd 
vfHkxeu (,Dlsl) dj ldrk gSA

	 	 (A)	 16 ; 64 fdyksckbV

	 	 (B)	 16 ; 32 fdyksckbV

	 	 (C)	 8 ; 32 fdyksckbV

	 	 (D)	 8 ; 64 fdyksckbV

25.	 VSEij çksVsD'ku (Tamper Protection) ,d ,slk 
Qhpj gS tks vukf/kÏr ,Il dks vkidh lqj{kk 
lsfVax cnyus ls jksdrk gSA fuEufyf[kr esa ls 
dkSu&lk vkWijsfVax flLVe bls liksVZ djrk gS\

	 	 (A)	 foaMkst 10	 (B)	 foaMkst ,Dlih

	 	 (C)	 fyuDl	 (D)	 foaMkst foLVk

26.	 ,e,l ikWojikWbaV esa vxyk ,uhes'ku ijQkWeZ 
djus ;k vxyh LykbM ij tkus ds fy, 
dkSu&lk fodYi ç;qä ugha fd;k tkrk gS\

	 	 (A)	 Enter	 (B)	 N

	 	 (C)	 Shift+F5	 (D)	Page Down

27.	 bZesy esa 'lCtsDV ykbu' dk D;k mís'; gksrk gS\

	 	 (A)	 bZesy ds fo"k; dk laf{kIr lkjka'k nsuk

	 	 (B)	 bZesy ds çkIrdrkZvksa dh lwph nsuk

	 	 (C)	 bZesy ds lkFk vVSpesaV 'kkfey djuk

	 	 (D)	 bZesy ds daVsaV dk foLr`r fooj.k çnku 
djuk

28.	 fLofpax fMokbl ds :i esa ekbØksizkslslj fdl 
ih<+h ds dEI;wVj ds fy, gS\

	 	 (A)	 igyh ih<+h	 (B)	 nwljh ih<+h

		  (C)	 rhljh ih<+h	 (D)	pkSFkh ih<+h

29.	 ,d dEI;wVj esa] lHkh gVkbZ x;h Qkbysa dgk¡ 
tkrh g®\

		  (A)	 MsLdVkWi	 (B)	 jhlkbfdy fcu

		  (C)	 ekbZ dEI;wVj	 (D)	daVªksy iSuy

30.	 ,d ekdZvi ySaXost vkSj vfu;fU=r MkVk 
dks LVksj djus] lapkfjr djus vkSj iqufuZekZ.k 
(arbitrary) djus ds fy, mi;ksx fd, tkus 
okys Qkby QkWesZV dks ------------ ds :i esa tkuk 
tkrk gSA

		  (A) 	HTML	 (B) 	XML
		  (C) 	 EML	 (D) 	SGML

31.	 QksjVªkWu&igyh mPp Lrjh; daI;wVj çksxzkfeax 
Hkk"kk fdlus cukbZ\ 

		  (A)	 ySjh ,fylu 	 (B)	 ekdZ ,aMªhlsu 

		  (C)	 tkWu cSdl 	 (D)	MSu fczdfyu

32.	 fuEufyf[kr esa ls dkSu&lk ;qXe lgh ugha gS \

	 	 I.	 Vp iSM & yksdsVj fMokbl

		  II.	 ekbØksQksu & vkmViqV fMokbl

		  III.	 ekWuhVj & vkmViqV fMokbl

		  (A)	 I rFkk II	 (B)	 I rFkk III
		  (C)	 dsoy II	 (D)	mi;qZDr lHkh

33.	 ekbØkslkW¶V ikojIokbaV esa LykbM isLV djus 
ds fy, buesa ls fdl 'kkWVZdV dqath dk mi;ksx 
fd;k tkrk gS\

		  (A)	 Ctrl + C	 (B)	 Ctrl + X
		  (C)	 Ctrl + V	 (D)	Ctrl + P

34.	 fuEufyf[kr esa ls dkSu&lk mÙke xq.koÙkk okyk 
xzkfQDl fçaVj gS\

	 	 (A)	 Laser Printer
	 	 (B)	 Plotter
	 	 (C)	 Ink Jet Printer
	 	 (D)	 Dot Matrix Printer

35.	 ,ukykWx daI;wVj esa _________A

(A)	buiqV dHkh fMftVy :i esa ifjofrZr 
ugha gksrk gSA

(B)	 vkmViqV fMftVy :i esa çnf'kZr gksrk 
gSA

(C)	 buiqV dks igys fMftVy :i esa 
ifjofrZr fd;k tkrk gSA

(D)	Åij ds lHkhA

36.	 fuEufyf[kr esa ls fdl dekaM dk mi;ksx 
Qkbyksa dh rqyuk djus ds fy, fd;k tkrk gS\
(A) 	Du	 (B) 	Cmp
(C)	 Cp	 (D)	 Comp

37.	 fuEufyf[kr esa ls fdldk mi;ksx MsLdVkWi ij 
vkbdu fNikus ds fy, fd;k tkrk gS\

	 	 (A)	 Desktop Icon Disappear
		  (B) 	 Hidden
		  (C) 	 Hide Shortcut
		  (D) 	Hide Icon

38.	 fuEufyf[kr esa ls fdl 'kkWVZdV dqath dk mi;ksx 
fyczsvkWfQl esa fdlh MkWD;wesaV ls ckgj fudyus 
ds fy, fd;k tkrk gS\
(A) 	Ctrl+l	 (B) Ctrl+w
(C) 	Ctrl+q	 (D) Ctrl+r

39.	 fuEu esa ls fdl esuw fodYi dk mi;ksx 
fyczsvkWfQl jkbVj esa *Lisy psdj* dks 'kq: 
djus ds fy, fd;k tkrk gS\

		  (A) 	Tools > Automatic Spell Checking
		  (B) 	 Format > Automatic Spell Checking
		  (C) 	 Format > Spell Checking
		  (D) 	Tools > Spell Checking

40.	 fyczsvkWfQl dSYd ds use ckWDl esa D;k çnf'kZr 
gksrk gS\

		  (A) 	Column Name	 (B) 	Cell Address

		  (C) 	 Sheet Name	 (D)	None

la[;kRed ;ksX;rk

41.	 fuEu esa ls dkSu-lh tksM+h] V~ohu izkbEl dh ,d 
tksM+h ugha gS\

		  (A)	 71, 73	 (B)	 131, 133
		  (C)	 191, 193	 (D)	11, 13

42.	 (98)68×(55)62×(27)91 esa bdkbZ LFkku ij 
dkSu&lk vad gS \

		  (A)	 0	 (B)	 6
		  (C)	 5	 (D)	2

43.	 ;fn 85 vkSj 255 ds y?kqÙke lekioR;Z dks 85R 
+ 255 ds :i esa O;ä fd;k tk ldrk gS] rks 
R dk eku Kkr dhft,A

	 	 (A)	 0	 (B)	 10
	 	 (C)	 6	 (D)	14

44.	 ;fn X = 
1

1 2

1

2 3

1

3 4×
+

×
+

×  + ... + 

(10 in) vkSj Y = 
1

4 5

1

5 6

1

6 7

1

7 8×
+

×
+

×
+

×
 

1

4 5

1

5 6

1

6 7

1

7 8×
+

×
+

×
+

×
+ ....+ (10 in), rc X vkSj Y dk 

vkSlr Kkr dhft,A

		 (A)	
533

616 	 (B)	
353

616

		 (C)	
435

616
	 (D)	

335

616
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45.	 	 ,d d{kk esa Nk=ksa dk vkSlr Hkkj 49 fdxzk- gSA 
d{kk esa 5 vkSj Nk=ksa us izos'k fy;k gS ftuds Hkkj 
45 fdxzk, 46.8 fdxzk, 47.4 fdxzk, 54.2 fdxzk 
vkSj 63.6 fdxzk gSaA vc d{kk esa lHkh Nk=ksa dk 
vkSlr Hkkj 50 fdxzk gks tkrk gSA vkjaHk esa d{kk 
esa Nk=ksa dh la[;k fdruh Fkh \

(A)	 7	 (B)	 8
(C)	 10	 (D)	 12

46.	 A vkSj B nks d{kk,¡ gSa ftuesa Nk=ksa dh ,d 
fuf'pr la[;k gSA ;fn 5 Nk=ksa dks A ls B esa 
LFkkukarfjr fd;k tkrk gS] rks B esa Nk=ksa dh 
la[;k A esa Nk=ksa dh la[;k ls nksxquh gks tkrh 
gSA ;fn 1 Nk= dks B ls A esa LFkkukarfjr fd;k 
tkrk gS] rks nksuksa d{kkvksa esa Nk=ksa dh la[;k 
leku gks tkrh gSaA B esa fdrus Nk= gSa\

	 	 (A)	 17	 (B)	 22
	 	 (C)	 26	 (D)	19

47.	 	 la[;k ‘a’ la[;k ‘e’ ds O;qRØekuqikrh gS] vkSj 
a = 50 gksus ij e = 22 gSA ‘a’ vkSj ‘e’ ls 
lEcfUèkr lehdj.k Kkr dhft,A 

(A)
	

a
e

=
1100

	
(B)	 e = 11a

(C)	 a = 13e
	

(D)
	

a
e

=
1213

48.	 ekuoh dh orZeku vk;q ds nksxqus vkSj ruoh dh 
orZeku vk;q dk ;ksx 35 o"kZ gSA ruoh ds firk 
dh vk;q] orZeku esa ruoh dh vk;q dh rhu xquh 
gSA ekuoh ds HkkbZ dh orZeku vk;q] ekuoh dh 
orZeku vk;q ls 6 o"kZ vf/kd gSA ruoh ds firk 
vkSj ekuoh ds HkkbZ dh orZeku vk;q dk ;ksx 
56 o"kZ gSA ekuoh vkSj ruoh dh orZeku vk;q 
dk ;ksx (o"kZ esa) Kkr dhft,A

		  (A)	 27	 (B)	 31
		  (C)	 23	 (D)	24

49.	 ;fn fdlh oLrq ds ewY; esa 36% dh o`f¼ dh 

tkrh gS] rks mlds miHkksx es fdrus çfr'kr 

(n'keyo ds 1 LFkku rd lfUudfVr) dh 

deh djuh gksxh rkfd oLrq dk O;; leku jgs\
	 	 (A)	 32%	 (B)	 29.5%

	 	 (C)	 36%	 (D)	26.5%

50.	 ;fn ,d vk;r dh yEckbZ eas 70%, dh o`f¼ 
dh tkrh gS] rks mlh {ks=Qy dks cuk;s j[kus 
ds fy, mldh pkSM+kbZ eas fdrus izfr'kr dh deh 
gksxh\ (fudVre iw.kk±d ds fy, lgh)A

		  (A)	 61%	 (B)	 60%
		  (C)	 42%	 (D)	 58%

51.	 fdlh est dks A, B dks 40% ykHk ij csprk 
gSA B, D dks 60 izfr'kr ykHk ij csprk gSA W 
,d dqlhZ L, X dks 20% gkfu ij csprk gSA 

X bls P dks 30% gkfu ij csprk gSA vUrr% 
P bls G dks 50% gkfu ij csprk gSA D, B ls 
tks est [kjhnrk gS mldh dher P tks X ls 
dqlhZ [kjhnrk gS] ds leku gSA ;fn W tks dqlhZ 
[kjhnrk gS mldh dher ̀  600 gS] rc D fdl 
dher ij est [kjhnrk gS\ 

		  (A)	 ` 336	 (B)	` 396

		  (C)	 ` 219	 (D)	` 348

52.	 	 ,d oLrq dks mlds foØ; ewY; ds 
9

11  
ij 

cspus ij] e/kq dks 10% dh gkfu gksrh gSA ;fn 
og oLrq dks mlds okLrfod foØ; ewY; ds 
95% ij csprh gS] rks ykHk izfr'kr (n'keyo 
ds ,d LFkku rd lgh) D;k gksxk\
(A)	 5.4%	 (B)	 4.5%
(C)	 6.8%	 (D)	 3.8%

53.	 X rFkk Y, lksus vkSj IySfVue dh nks feJ èkkrq,¡ 
gSa] tks bu /kkrqvksa dks Øe'k% 5 : 2 vkSj 5 : 7 
ds vuqikr esa feykdj rS;kj dh xbZ gSA ;fn 
ge bu feJ /kkrqvksa dh leku ek=kvksa dks 
fi?kykdj ,d rhljh feJ /kkrq Z cukrs gS] rks 
Z esa lksus dh ek=k vkSj IySfVue dh ek=k dk 
vuqikr D;k gksxk\

		  (A)	 84 : 73	 (B)	 73 : 95
		  (C)	 95 : 73	 (D)	95 : 84

54.	 vfjgar ,d fuf'pr dke djuk 'kq: djrk gSA 
4 fnuksa ds ckn] v#.k] tks vfjgar ls vkèkk 
dk;Zdq'ky gS] mlh dk;Z ij dk;Z djuk 'kq: 
djrk gSA urhtu] dke 9 fnuksa esa iwjk gksrk gSA 
;fn v#.k vdsys dk;Z djrk gS rks dk;Z dks 
iwjk djus esa fdruk le; yxsxk\

		  (A)	 35 fnu	 (B)	 38 fnu

		  (C)	 39 fnu	 (D)	32 fnu

55.	 ` 8,000 dh /kujkf'k dk vkaf'kd :i ls 2 o"kZ 
ds fy, ;kstuk 1 esa 5% lk/kkj.k C;kt dh 
nj ls vkSj 'ks"k /kujkf'k dk ;kstuk 2 esa 4% 
lk/kkj.k C;kt dh nj ls fuos'k fd;k tkrk gSaA 
vof/k ds var esa çkIr dqy C;kt ` 720 FkkA 
;kstuk 1 es fuos'k dh xbZ /kujkf'k fdruh gS\

	 	 (A)	 ` 4,400	 (B)	 ` 7,200
	 	 (C)	 ` 3,640	 (D)	` 4,000

56.	 nks LVs'kuksa fnYyh vkSj ve`rlj ds chp dh nwjh 
450 fdeh gSA fnYyh ls ,d Vsªu 4 p.m. ij 60 
fdeh@?ka- dh vkSlr pky ls ve`rlj ds fy, 
jokuk gksrh gSA ve`rlj ls ,d vU; Vsªu 3:20 
p.m. ij 80 fdeh@?ka- dh vkSlr pky ls fnYyh 
ds fy, jokuk gksrh gSA fnYyh ls fdruh nwjh 
ij nksuksa Vsªusa feysaxh\ 

		  (A)	 160 fdeh-	 (B)	180 fdeh-

		  (C)	 170 fdeh-	 (D)	165 fdeh-

57.	 uhps fn;k x;k ikbZ pkVZ fofHkUu daifu;ksa  
}kjk Hksts x, fÝt dh la[;k dks n'kkZrk gSA bu 
lHkh Ng daifu;ksa }kjk csps x, fÝt dh dqy 
la[;k 7200 gSA ,d fof'k"V daiuh }kjk Hksts 
x, fÝt dh la[;k dks bu lHkh 6 daifu;ksa  
}kjk Hksts x, fÝt dh dqy la[;k ds lacaèk esa 
fMxzh ds :i esa n'kkZ;k x;k gSA

	

P
80º

U
30ºT

25º
S

15º

R
140º

Q
70º

		  J1= R, S rFkk T }kjk csps x, fÝt dh vkSlr 
la[;kA

			 J2 = P rFkk Q }kjk csps x, fÝt dh vkSlr 
la[;k rFkk S rFkk U }kjk csps x, fÝt dh 
vkSlr la[;k dk ;ksxA

			 (J2–J1) dk eku D;k gS \
		  (A)	 650	 (B)	 675
		  (C)	 450	 (D)	750
58.	 uhps nh xbZ rkfydk 3 o"kks± esa 6 daifu;ksa ds 

mRiknu dks n'kkZrk gSA

dEiuh
o"kZ

Y1 Y2 Y3

C1 20 40 80
C2 30 20 70
C3 50 72 48
C4 40 60 16
C5 60 50 24
C6 26 90 36

		  lHkh 3 o"kks± esa daiuh C1 ds dqy mRiknu dk 
daiuh C2 ds dqy mRiknu ls D;k vuqikr gS\

		  (A)	 12:7	 (B)	 9:7
		  (C)	 7:3	 (D)	7:6
59.	 fuEufyf[kr xzkQ dqN lsy Qksu daifu;ksa ds 

fy, tqM+s u, mi;ksxdrkZ vkSj NksM+us okys 
mi;ksxdrkZvksa dks n'kkZrk gSA ;fn daiuh C esa 
tqM+s x, mi;ksxdrkZvksa dh dqy la[;k 54000 
gS rks daiuh A esa tqM+s u, mi;ksxdrkZ Kkr djsaA

 
		  (A)	 80000	 (B)	 85000
		  (C)	 95000	 (D)	90000
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60.	 fn;k x;k ikbZ pkVZ fdlh dEiuh }kjk 6 o"kZ esa 
mRikfnr cYcksa dh la[;k dks n'kkZrk gSA fdlh 
o"kZ esa mRikfnr cYcksa dh la[;k] lHkh o"kks± esa 
mRikfnr cYcksa dh la[;k ds izfr'kr ds :i esa 
iznf'kZr dh xbZ gSA

		

Y1,

10%

Y2,

20%

Y3,

30%

Y4,

10%

Y5,

14%

Y6,

16%

	 	 ;fn 6 o"kks± esa mRikfnr cYcksa dh la[;k 
1,00,000 gS] rks o"kZ Y3 rFkk Y5 esa mRikfnr 
cYcksa dh la[;k dk vUrj fdruk gS\

	 	 (A)	 11000	 (B)	10000		
(C)	 13000	 (D)	16000

lkekU; rdZ'kfDr

61.		 fuEufyf[kr 'kCnksa dks 'kCndks'k esa vkus okys 
Øe ds vuqlkj fy[ksaµ

		  (1)	 Cardiodynias	 (2)	 Cardiospasms
		  (3)	 Carburetting	 (4)	 Carburettors
		  (5)	 Carcinogenic
		  (A)	 34512	 (B)	 43512
		  (C)	 34521	 (D)	43521

62.	 ,d fuf'pr dksM Hkk"kk esa] ;fn BUCKINGHAM 
dks 79 ds :i es a dksfMr fd;k x;k gS] 
TRANSFORMER dks 136 ds :i esa dksfMr 
fd;k x;k gS] rks MASSACHUSETTS dks 
dSls dksfMr fd;k tk,xk\

		  (A)	 163	 (B)	 165
		  (C)	 153	 (D)	155

63.		 fuEufyf[kr ç'u esa] v{kjksa dk ,d lewg fn;k 
x;k gSA çR;sd lewg ds v{kj mlh lewg ds 
v{kjksa ds lkFk fdl rdZ@ fu;e @lacaèk ls 
lacafèkr gSaA fn, x, fodYiksa esa ls v{kjksa ds ,d 
lewg dks pqfu, tks leku rdZ@fu;e@lacaèk dk 
vuqlj.k djrk gksA

		  (VM, WN, XO)
		  (A)	 (JN, LO, MP)	 (B)	 (AD, BE, CG)
		  (C)	 (ST, TU, UV)	 (D)	 (EP, DQ, CR)

64.		 pkj v{kj&lewg fn, x, gSa] ftuesa ls rhu fdlh 
izdkj ls leku gSa vkSj ,d vyx gSA fHkUu v{kj 
&lewg dk p;u dhft;sA

		  (A)	 EIMQ	 (B)	 DHLP
		  (C)	 EJNS	 (D)	TXBF
65.		 fuEufyf[kr Ük`a[kyk esa fdrus 3 ,sls gSa ftuds 

Bhd igys 9 gS ijarq Bhd ckn 5 ugha gS\
		  9 3 4 5 9 3 5 9 3  6 4 3 9 3 3 5 3 9 9 5 3 9 

3 7 5 7 5 9 3 9 5
		  (A)	 4 	 (B)	 3
		  (C)	 5	 (D)	2

66.	 vkB O;fDr;ksa ds ,d ifjokj esa] nks ;qxy gSa] 
nksuksa ;qxy ds nks&nks cPps gSA B vkSj D HkkbZ 
gSa] vkSj mu nksuksa ds nks&nks cPps gSaA E, A dh 
pkph gS] A, C dk ppsjk HkkbZ gSA C, H dh cgu 
gS] H, G dk ppsjk HkkbZ gSA F, B dh iRuh gSA H 
fdl izdkj F ls lacafèkr gS \

		  (A)	 lkyk	 (B)	 Hkrhtk

		  (C)	 nkekn	 (D)	iq=

67.	 uhps ,d Ük`a[kyk nh xbZ gS ftlesa ,d in yqIr 
gSA fn, x, fodYiksa esa ls ml fodYi dk p;u 
dhft, tks Ük`a[kyk dks iwjk djsxkA 

		  BSWG, CTXE, DUYC, ?, EWAY
		  (A)	 ZVEA	 (B)	 EVZA
		  (C)	 AAZV	 (D)	VEAZ

68.	 fuEufyf[kr esa ls dkSu&lh la[;k nh xbZ Ükà[kyk 
esa iz'ufpÊ (\) ds LFkku ij vk,xh \ 

		  46, 54, 70, 102, 166, ?
		  (A)	 290	 (B)	 305
		  (C)	 294	 (D)	314

69.	 ;fn I dk vFkZ ‘÷’ gS] J dk vFkZ ‘×’ gS] K dk 
vFkZ ‘–’ gS] vkSj L dk vFkZ ‘+’ gS rks fuEufyf[kr 
lehdj.k esa ‘?’ ds LFkku ij D;k vk,xk \

		  29 J 7 K 1 68 I 4 L 7 1 K 39 L 1 4 J 2 =  ?
		  (A)	 221	 (B)	 216
		  (C)	 228	 (D)	235

70.	 ,d gh ikls dh nks vyx&vyx fLFkfr;ksa dks 
n'kkZ;k x;k gS ftl ij 1 ls 6  rd dh la[;k,¡ 
fcanq ds :i esa fu:fir gSaA '2' n'kkZus okys Qyd 
ds foijhr Qyd ij fLFkr la[;k dhft,A

		  	

		  (A)	 4	 (B)	 3
		  (C)	 1	 (D)	5

71.	 ml osu vkjs[k dk p;u djsa tks fuEufyf[kr 
oxks± ds chp ds lEcU/k dks loksZÙke :i ls n'kkZrk 
gS rFkk oxks± ds ml leqPp; dk p;u dhft, 
ftuds chp dk lEcU/k fuEufyf[kr osu vkjs[k 
}kjk loksZÙke :i n'kkZ;k x;k gSA

		  A MkWDVjksa dks fn[kkrk gS] B fi;kuks okndksa 
dks fn[kkrk gS] C ys[kdksa dks n'kkZrk gS vkSj D 
xk;dksa dks n'kkZrk gSA dkSu&lk dFku vR;ar 
mi;qDr gS \

		

		  (A)	 lHkh xk;d MkWDVj gSaA

		  (B)	 lHkh ys[kd vkSj fi;kuksoknd MkWDVj gaSA

		  (C)	 lHkh fi;kuksoknd xk;d gSaA

		  (D)	 mi;qZDr esa ls dksbZ ughaA

72.	 fuEufyf[kr iz'u esa dqN dFku vkSj mu dFkuksa 
ds vk/kkj ij dqN fu"d"kZ fn, x, gSaA vkidks 
fn, x, dFkuksa dks lR; ekuuk gS] pkgs os 
lkekU;r% Kkr rF;ksa ls fHkUu izrhr gksrs gksaA 
lHkh fu"d"kks± dks /;kuiwoZd if<+, vkSj fu'p; 
dhft, fd fn, x, fu"d"kks± esa ls dkSu-lk@dkSu-
ls fu"d"kZ dFkuksa dk rkfdZd :i ls vuqlj.k 
djrk gS@djrs gSaA

		  dFku % 

		  lHkh vk¡[ksa ukd gSaA

		  dqN ukd gksaB gSaA

		  fu"d"kZ %

		  I. dqN ukd vk¡[ksa gSaA

		  II. lHkh gksaB ukd gSaA 

		  (A)	 nksuksa fu"d"kZ vuqlj.k djrs gSaA

		  (B)	 u rks fu"d"kZ I vuqlj.k djrk gS vkSj u  
	gh II vuqlj.k djrk gSA

		  (C)	 dsoy fu"d"kZ I vuqlj.k djrk gSA

		  (D)	 dsoy fu"d"kZ II vuqlj.k djrk gSA

73.	 tkWu us 'kqØokj] 21 tuojh] 2022 dks ,d 
fiYyk [kjhnkA tkWu }kjk mls [kjhnus ds ckn 
ls 380osa fnu fiYyk ,d o;Ld dqÙkk cu x;kA 
fiYyk fdl fnu o;Ld cu x;k\

		  (A)		 jfookj	 (B)	lkseokj

		  (C)		 'kfuokj	 (D)	cq/kokj

74.	 P] Q] R] S] T] U vkSj ,d xksy est ds ifjr% 
dsUæ dh vksj vfHkeq[k gksdj cSBs gSaA U] T ds 
Bhd nk,a iM+ksl esa cSBk gSA U ds ck,a ls fxuus 
ij U vkSj V ds chp dsoy rhu yksx cSBs gSaA 
T vkSj R ds chp dsoy rhu yksx cSBs gSaA Q] 
P ds Bhd nk,a iM+ksl esa cSBk gSA P ds ck,a ls 
fxuus ij T vkSj P ds chp fdrus yksx cSBs gSa\

		  (A)	 2	 (B)	 4
		  (C)	 3	 (D)	 1

75.	 ‘#’ dk vFkZ ‘>’ gS]
		  ‘$’ dk vFkZ ‘>’ gS]
		  ‘%’ dk vFkZ ‘<’ gS] vkSj

		  ‘@’ dk vFkZ ‘<’ gS]
		  fuEufyf[kr tkudkjh dks lR; ekurs gq, fu.kZ; 

dhft,] fd fodYiksa esa fn, x, fu"d"kks± esa ls 
dkSu&ls fuf'pr :i ls lR; gSa \

		  B $ D $ A
		  R % D % L @ J
		  (A)	 J % D	 (B)	 A % L
		  (C)	 B $ J	 (D)	B # L
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76.	 N% O;fä P, Q, R, S, T vkSj U ,d gh bekjr 
dh N% vyx&vyx eaftyksa ij jgrs gSaA bekjr 
dh lcls fupyh eafty dh la[;k 1 gS_ blds 
Åij dh eafty dks 2 ds :i esa vkSj blh rjg 
vkxs Hkh la[;kafdr fd;k x;k gSA lcls Åijh 
eafty dh la[;k 6 gSA

P ,d le la[;k okyh eafty ij jgrk gS] 
ysfdu eafty la[;k 4 ij ughaA S vkSj P ds 
chp dsoy nks O;fä jgrs gSaA R]T ds Bhd uhps 
jgrk gSA U ,d le la[;k okyh eafty ij 
jgrk gSA Q lcls fupyh eafty ij ugha jgrk 
gSA Q vkSj S ds chp fdrus O;fä jgrs gSa\

	 	 (A)	 rhu	 (B)	 pkj

	 	 (C)	 ,d	 (D)	nks

77.	 ml fodYi dk p;u djsa tks rhljs fp= ls 
mlh rjg lEcfU/kr gS ftl rjg nwljk fp= 
igys fp= ls lEcfU/kr gSA

: : : : ?

		  (A)	 	 (B)	

		  (C)	 	(D)	

78.	 iz'ufpÊ dh txg ds fy, lgh vkÏfr 
pqus aA

	    leL;k vkÏfr;k¡

    	   
	    mÙkj vkÏfr;k¡

	      
            1                2                3               4
		  (A)	 4	 (B)	 3
		  (C)	 2	 (D)	1

79.	 og vkÏfr pqusa tks nwljksa ls fHkUu gks\

		

(A)	

	

(B)	

		

(C)	

	

(D)	

80.	 uhps fy[ks dFku dks lR; ekurs gq, ;g fu.kZ; 

dfj, fd blls fuf'pr :i ls uhps fn, gq, 

dkSu-ls fu"d"kZ fudkys tk ldrs gSaA

		  dFkuµ

		 dqN vfHkusrk O;kikjh gSaA

		  lHkh O;kikjh cqf¼eku gksrs gSaA

		  fu"d"kZµ

		  I.	 lHkh vfHkusrk cqf¼eku gSaA

		  II.	 lHkh O;kikjh vfHkusrk gSaA

		  (A)	 dsoy fu"d"kZ II vuqlj.k djrk gS

		  (B)	 u rks I vkSj u gh II vuqlj.k djrk gS

		  (C)	 dsoy fu"d"kZ I vuqlj.k djrk gS

		  (D)	 I vkSj II nksuksa vuqlj.k djrs gSa

¥gnh

funsZ'k (iz'u la[;k 81 ls 85 rd)

fuEufyf[kr x|ka'k dks /;kuiwoZd if<+, rFkk ml 
ij vk/kkfjr iz'uksa ds mÙkj nhft,A

/kjkry ls ;q¼ dh foHkhf"kdkvksa dks lnk-lnk ds fy, 

lekIr djus ds fy, xk¡èkhth us fo'o dks vfgalk :ih 

vL= iznku fd;kA xk¡èkhth dgk djrs Fks fd izse vkSj 

vfgalk ds }kjk fo'o ds dBksj ls dBksj ân; dks Hkh 

dksey cuk;k tk ldrk gSA mUgksaus bu fl¼kUrksa dk 

ijh{k.k Hkh fd;k vkSj os ^furkUr* lQy fl¼ gq,A 

fgalk ls fgalk c<+rh gS] ^?k`.kk*] ?k`.kk dks tUe nsrh gS] 

vkSj izse ls izse dh vfHko`f¼ gksrh gSA vr% ;g fuf'pr 

gS] fd fcuk izse vkSj vfgalk ds fo'o esa 'kkfUr LFkkfir 

ugha gks ldrhA 'kkfUr ds vHkko esa ekuo tkfr dk 

fodkl lEHko ughaA izR;sd jk"Vª dk Lof.kZe-;qx ogh 

dgk tkrk gS] tcfd ogk¡ iw.kZ 'kkafr vkSj lq[k jgk gks 

rFkk mÙkeksÙke jpukRed dk;Z fd, tkrs gksaA HkkSfrd 

n`f"V ls O;kikj vkSj Ïf"k dh mékfr Hkh 'kkafrdky esa 

gh lEHko gksrh gS] vr% ge ;fn fo'o dk dY;k.k 

pkgrs gSa] rks gesa ;q¼ dk cfg"dkj djuk gh gksxkA 

vfgalk vkSj izse dh Hkkouk ls fo'o esa 'kkfUr LFkkfir 

djuh gksxh] rHkh fo'o esa lq[ke; ,oa 'kkafre; jkT; 

dh LFkkiuk lEHko gksxhA

81.	 fo'o 'kkafr dh LFkkiuk ds fy, lcls vko';d 
gSµ

		  (A)	 ifjJe vkSj Kku
	 	 (B)	 vkReh;rk vkSj lehirk
		  (C)	 vfgalk vkSj izse	
	 	 (D)	 fgalk vkSj Hk;

82.	 dBksj ls dBksj ân; dks Hkh dksey cuk;k tk 

ldrk gSµ

		  (A)	 Hk; }kjk	 (B)	 vfgalk }kjk

		  (C)	 ekSu ikyu }kjk	 (D)	lR; ikyu }kjk

83.	 fdlh Hkh jk"Vª ds Lof.kZe-;qx ds izeq[k rÙo gSaµ

		  (A)	 'kkfUr] lq[k vkSj jpukRed dk;Z

	 	 (B)	 vk/;kRe vkSj mikluk

		  (C)	 /ku vkSj lEeku

	 	 (D)	 /ku vkSj oSHko

84.	 ^furkUr* 'kCn dk mi;qDr i;kZ; gSµ

		  (A)	 fuEu	 (B)	 fof/kor~

		  (C)	 fcydqy	 (D)	 HkyhHkk¡fr

85.	 fo'o esa 'kkafr D;ksa vko';d gS\
		  (A)	 dBksj ls dBksj ân; dks Hkh dksey cukus 

ds fy,
	 	 (B)	 O;kikj vkSj Ïf"k dh mékfr ds fy,

		  (C)	 mÙkeksÙke jpukRed dk;Z ds fy,

	 	 (D)	 ekuo tkfr ds fodkl ds fy,

86.	 ^vR;kpkj* dk lgh laf/k-foPNsn gS %

		  (A)	 vfr;k $ pkj	 (B)	 vr~ $ vkpkj

		  (C)	 vfr $ vkpkj	 (D)	vR;k $ pkj

87.	 L=h¥yx-iqfYyax dk dkSu-lk tksM+k lgh ugha gS\

		  (A)	nso-nsoh	 (B)	ekek-ekeh

		  (C)	dkUr-dkUrh	 (D)	xèkk-xèkh

88.	 fuEufyf[kr rRle-rn~Hko 'kCnksa dk laxr 
;qXe gSµ

		  (A)	 [kiZV - [kksiM+h	 (B)	 läq - lR;

		  (C)	 i;±d - iyax	 (D)	 ?kksVd - ?kM+k

89.	 fuEufyf[kr esa ls dkSu&lk 'kCn ^dey* dk 

i;kZ;okph ugha gS \

		  (A)	 uhjt	 (B)	 mRiy

		  (C)	 vjfoUn	 (D)	okfjn

90.	 ^mFkyk* 'kCn dk foykse gSµ

		  (A)	xgjk	 (B)	 fNNyk

		  (C)	 lery	 (D)	mHkkj

English

Direction (Q. No. 91 to 95)
Read the passages carefully and choose the 
best answer to each question. Out of the four 
alternatives.

Earth Day is an apt moment to consider how 
our planet, a majestic 4.54 billion years old, 
is faring. The statistics are not pleasing. Once 
covered in verdant green, FAO finds Earth 
has now lost one-third of its forests through 
human activity. WWF estimates such land-use 
changes have caused wildlife to decline by 
69% in the last 50 years. The loss of natural 
ecosystems and their engineers, which includes 
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birds, animals, insects and fungi, is literally 
drying up the world. The UN finds 75% of 
Earth's land is degraded while its oceans are 
30% more acidic now, choked by plastic and 
chemical waste. Neither is the air pristine - as 
pollutants coat the skies, the World Economic 
Forum finds global CO2 emissions rose in 
2022 to a record high. Such CO2 covers Earth 
in a sheath which doesn't let it release heat into 
space, trapping this in the atmosphere instead, 
making Earth 1.11 degrees warmer.

91.	 Select the most appropriate title for the 
given passage.

		  (A)	 Nature and Animals

		  (B)	 Earth and its Dangers

		  (C)	 Earth and Nature

		  (D)	 Animals and Birds

92.	 Select the tone of the passage.

		  (A)	 Cautionary	 (B)	 Entertaining

		  (C)	 Narrative	 (D)	 Persuasive

93.	 Who caused the loss of forests?

		  (A)	 Realtors	 (B)	 People

		  (C)	 Nature	 (D)	 Animals

94.	 Who are the engineers NOT mentioned 
in the passage?

		  (A)	 Eggs	 (B)	 Insects

		  (C)	 Fungi	 (D)	 Birds

95.	 Select the most appropriate ANTONYM 

of the word 'decline'.

		  (A)	 Drag	 (B)	 Decrease

		  (C)	 Push	 (D)	 Increase 

96.	 Given below a sentence. Identify the 

part of speech of the underlined word. 

Choose the response (A), (B), (C) or (D) 

which is the most appropriate expression.

		  He thought the movie ended abruptly.

		  (A)	 Noun	 (B)	 Adverb

		  (C)	 Verb	 (D)	 Adjective

97.	 Change the voices of these sentences.

		  Who did this mischief ?

		  (A)	 By whom was this mischief done ?

		  (B)	 Who was this mischief done by ?

		  (C)	 Was this mischief done by you ?

		  (D)	 By whom is this mischief done ?

98.	 Choose the option which is the correct 

indirect form of the given sentence.

		  The traffic policeman said to the driver, 
“Why did you not stop when the traffic 
light was red ?”

		  (A)	 The traffic policeman asked the 
driver why he has not stopped when 
the traffic light was red.

		  (B)	 The traffic policeman asked the driv-
er why you had not stopped when the 
traffic light was red.

		  (C)	 The traffic policeman asked the driv-
er if he had stopped when the traffic 
light was red.

		  (D)	 The traffic policeman asked the driv-
er why he had not stopped when the 
traffic light was red.

99.	 Choose the word that means the same as 
the given word.

		  		Ardent

		  		(A)	 Lovable	 (B)	 Passionate

		  (C)	 Withdrawn	 (D)	Denture

100.	 Find out which part of a sentence (A), (B) 
or (C) has an error. If there is no error your 
answer is (D)

		  Each of these girls (A) / play (B) / games. 
(C) / No error (D)

qq
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